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Chapter 470

Equivalence Tests for
the Ratio of Two Means
(Log-Normal Data)
Introduction
This procedure calculates power and sample size of statistical tests for equivalence tests from parallel-group design
with two groups when the data are assumed to follow a log-normal distribution. This routine deals with the case in
which the statistical hypotheses are expressed in terms of mean ratios rather than mean differences.
The details of testing the equivalence of two treatments using a parallel-group design are given in the chapter
entitled Equivalence Tests for Two Means using Differences and will not be repeated here. If the logarithms of the
responses can be assumed to follow a normal distribution, hypotheses about equivalence in terms of the ratio can be
transformed into hypotheses about the difference. The details of this analysis are given in Julious (2004).
Note that when the data follow a normal distribution rather than the log-normal distribution, you should use another
PASS procedure entitled Equivalence Tests for the Ratio of Two Means (Normal Data) to obtain more accurate
results.

Equivalence Testing Using Ratios
PASS follows the two one-sided tests approach described by Schuirmann (1987) and Phillips (1990). It will be
convenient to adopt the following specialized notation for the discussion of these tests.
Parameter
𝜇𝜇𝑇𝑇

PASS Input/Output Interpretation
Not used
Treatment mean. This is the treatment mean.

𝑅𝑅𝐿𝐿 , 𝑅𝑅𝑈𝑈

𝜇𝜇𝑅𝑅

Not used

Reference mean. This is the mean of a reference population.

RL, RU

Equivalence Limits. These limits define an interval of the ratio of the
means in which their difference is so small that it may be ignored.

𝜙𝜙

R1

Actual ratio. This is the value of 𝜙𝜙 = 𝜇𝜇𝑇𝑇 /𝜇𝜇𝑅𝑅 at which the power is
calculated.

Note that the actual values of 𝜇𝜇𝑇𝑇 and 𝜇𝜇𝑅𝑅 are not needed. Only the ratio of these values is needed for power and
sample size calculations.
With 𝑅𝑅𝐿𝐿 < 1 and 𝑅𝑅𝑈𝑈 > 1, the null hypothesis of non-equivalence is
The alternative hypothesis of equivalence is

𝐻𝐻0 : 𝜙𝜙 ≤ 𝑅𝑅𝐿𝐿 or 𝜙𝜙 ≥ 𝑅𝑅𝑈𝑈 .
𝐻𝐻1 : 𝑅𝑅𝐿𝐿 < 𝜙𝜙 < 𝑅𝑅𝑈𝑈 .
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Log-Transformation
In many cases, hypotheses stated in terms of ratios are more convenient than hypotheses stated in terms of
differences. This is because ratios can be interpreted as scale-less percentages, but differences must be interpreted
as actual amounts in their original scale. Hence, it has become a common practice to take the following steps in
hypothesis testing.
1. State the statistical hypotheses in terms of ratios.
2. Transform these into hypotheses about differences by taking logarithms.
3. Analyze the logged data—that is, do the analysis in terms of the difference.
4. Draw the conclusion in terms of the ratio.
The details of step 2 for the alternative hypothesis are as follows:
𝜇𝜇𝑇𝑇
< 𝑅𝑅𝑈𝑈 ⇒ 𝐻𝐻1 : ln(𝑅𝑅𝐿𝐿 ) < ln(𝜇𝜇𝑇𝑇 ) − ln(𝜇𝜇𝑅𝑅 ) < ln(𝑅𝑅𝑈𝑈 )
𝐻𝐻1 : 𝑅𝑅𝐿𝐿 < 𝜙𝜙 < 𝑅𝑅𝑈𝑈 ⇒ 𝐻𝐻1 : 𝑅𝑅𝐿𝐿 <
𝜇𝜇𝑅𝑅

Thus, a hypothesis about the ratio of the means on the original scale can be translated into a hypothesis about the
difference of two means on the logged scale.
When performing an equivalence test on the difference between means, the usual procedure is to set the
equivalence limits symmetrically above and below zero. Thus, the equivalence limits will be plus or minus an
appropriate amount. The common practice is to do the same when the data are being analyzed on the log scale.
However, when symmetric limits are set on the log scale, they do not translate to symmetric limits on the original
scale. Instead, they translate to limits that are the inverses of each other.
Perhaps these concepts can best be understood by considering an example. Suppose the researchers have
determined that the lower equivalence limit should be 80% on the original scale. Since they are planning to use a
log scale for their analysis, they transform this limit to the log scale by taking the logarithm of 0.80. The result is 0.223144. Wanting symmetric limits, they set the upper equivalence limit to 0.223144. Exponentiating this value,
they find that exp(0.223144) = 1.25. Note that 1/(0.80) = 1.25. Thus, the limits on the original scale are 80% and
125%, not 80% and 120%.
Using this procedure, appropriate equivalence limits for the ratio of two means can be easily determined. Here are
a few sets of equivalence limits.

Specified
Percent
Change
-25%
+25%
-20%
+20%
-10%
+10%

Lower
Limit
Original
Scale
75.0%
80.0%
80.0%
83.3%
90.0%
90.9%

Upper
Limit
Original
Scale
133.3%
125.0%
125.0%
120.0%
111.1%
110.0%

Lower
Limit
Log
Scale
-0.287682
-0.223144
-0.223144
-0.182322
-0.105361
-0.095310

Upper
Limit
Log
Scale
0.287682
0.223144
0.223144
0.182322
0.105361
0.095310

Note that negative percent-change values specify the lower limit first, while positive percent-change values
specify the upper limit first. After the first limit is found, the other limit is calculated as its inverse.
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Coefficient of Variation
The coefficient of variation (COV) is the ratio of the standard deviation to the mean. This parameter can be used
to represent the variation in the data because of a unique relationship that it has in the case of log-normal data.
Suppose the variable X is the logarithm of the original variable Y. That is, X = ln(Y) and Y = exp(X). Label the
mean and variance of X as 𝜇𝜇𝑋𝑋 and 𝜎𝜎𝑋𝑋2 , respectively. Similarly, label the mean and variance of Y as 𝜇𝜇𝑌𝑌 and 𝜎𝜎𝑌𝑌2 ,
respectively. If X is normally distributed, then Y is log-normally distributed. Julious (2004) presents the following
well-known relationships between these two variables
𝜇𝜇𝑌𝑌 =

𝜎𝜎 2
𝜇𝜇𝑋𝑋 + 𝑋𝑋
2
𝑒𝑒

2

𝜎𝜎𝑌𝑌2 = 𝜇𝜇𝑌𝑌2 �𝑒𝑒 𝜎𝜎𝑋𝑋 − 1�

From this relationship, the coefficient of variation of Y can be found to be
𝐶𝐶𝐶𝐶𝐶𝐶𝑌𝑌 =

2

�𝜇𝜇𝑌𝑌2 �𝑒𝑒 𝜎𝜎𝑋𝑋 − 1�
𝜇𝜇𝑌𝑌

= �𝑒𝑒 𝜎𝜎𝑋𝑋 − 1
2

Solving this relationship for 𝜎𝜎𝑋𝑋2 , the standard deviation of X can be stated in terms of the coefficient of variation of
Y as

Similarly, the mean of X is

𝜎𝜎𝑋𝑋 = �ln(𝐶𝐶𝐶𝐶𝐶𝐶𝑌𝑌2 + 1)
𝜇𝜇𝑋𝑋 = ln �

𝜇𝜇𝑌𝑌

�𝐶𝐶𝐶𝐶𝐶𝐶𝑌𝑌2 + 1

�

Thus, the hypotheses can be stated in the original (Y) scale and then the power can be analyzed in the transformed
(X) scale. For parallel-group designs, 𝜎𝜎𝑋𝑋2 = 𝜎𝜎𝑑𝑑2 , the average variance used in the t-test of the logged data.

Power Calculation
As is shown above, the hypotheses can be stated in the original (Y) scale using ratios or the logged (X) scale
using differences. Either way, the power and sample size calculations are made using the formulas for testing the
equivalence of the difference in two means. These formulas are presented another chapter and are not duplicated
here.
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Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains the parameters associated with this test such as the means, sample sizes, alpha, and
power.

Solve For
Solve For
This option specifies the parameter to be solved for from the other parameters. Under most situations, you will
select either Power or Sample Size (N1).

Power and Alpha
Power
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis
and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null
hypothesis is not rejected. In this procedure, a type-II error occurs when you fail to reject the null hypothesis of
nonequivalent means when in fact the means are equivalent.
Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now,
0.90 (Beta = 0.10) is also commonly used.
A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.
Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true
null hypothesis is rejected. In this procedure, a type-I error occurs when you reject the null hypothesis of nonequivalent means when in fact the means are nonequivalent.
Values must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means that
about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents
the risk of a type-I error you are willing to take in your experimental situation.
You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.
You can enter a range of values such as 0.05, 0.10, 0.15 or 0.05 to 0.15 by 0.01.

Sample Size (When Solving for Sample Size)
Group Allocation
Select the option that describes the constraints on N1 or N2 or both.
The options are
•

Equal (N1 = N2)
This selection is used when you wish to have equal sample sizes in each group. Since you are solving for both
sample sizes at once, no additional sample size parameters need to be entered.
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•

Enter N2, solve for N1
Select this option when you wish to fix N2 at some value (or values), and then solve only for N1. Please note
that for some values of N2, there may not be a value of N1 that is large enough to obtain the desired power.

•

Enter R = N2/N1, solve for N1 and N2
For this choice, you set a value for the ratio of N2 to N1, and then PASS determines the needed N1 and N2,
with this ratio, to obtain the desired power. An equivalent representation of the ratio, R, is
N2 = R * N1.

•

Enter percentage in Group 1, solve for N1 and N2
For this choice, you set a value for the percentage of the total sample size that is in Group 1, and then PASS
determines the needed N1 and N2 with this percentage to obtain the desired power.

N2 (Sample Size, Group 2)
This option is displayed if Group Allocation = “Enter N2, solve for N1”
N2 is the number of items or individuals sampled from the Group 2 population.
N2 must be ≥ 2. You can enter a single value or a series of values.
R (Group Sample Size Ratio)
This option is displayed only if Group Allocation = “Enter R = N2/N1, solve for N1 and N2.”
R is the ratio of N2 to N1. That is,
R = N2 / N1.
Use this value to fix the ratio of N2 to N1 while solving for N1 and N2. Only sample size combinations with this
ratio are considered.
N2 is related to N1 by the formula:
N2 = [R × N1],
where the value [Y] is the next integer ≥ Y.
For example, setting R = 2.0 results in a Group 2 sample size that is double the sample size in Group 1 (e.g., N1 =
10 and N2 = 20, or N1 = 50 and N2 = 100).
R must be greater than 0. If R < 1, then N2 will be less than N1; if R > 1, then N2 will be greater than N1. You can
enter a single or a series of values.

Percent in Group 1
This option is displayed only if Group Allocation = “Enter percentage in Group 1, solve for N1 and N2.”
Use this value to fix the percentage of the total sample size allocated to Group 1 while solving for N1 and N2.
Only sample size combinations with this Group 1 percentage are considered. Small variations from the specified
percentage may occur due to the discrete nature of sample sizes.
The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single or a series of values.
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Sample Size (When Not Solving for Sample Size)
Group Allocation
Select the option that describes how individuals in the study will be allocated to Group 1 and to Group 2.
The options are
•

Equal (N1 = N2)
This selection is used when you wish to have equal sample sizes in each group. A single per group sample
size will be entered.

•

Enter N1 and N2 individually
This choice permits you to enter different values for N1 and N2.

•

Enter N1 and R, where N2 = R * N1
Choose this option to specify a value (or values) for N1, and obtain N2 as a ratio (multiple) of N1.

•

Enter total sample size and percentage in Group 1
Choose this option to specify a value (or values) for the total sample size (N), obtain N1 as a percentage of N,
and then N2 as N - N1.

Sample Size Per Group
This option is displayed only if Group Allocation = “Equal (N1 = N2).”
The Sample Size Per Group is the number of items or individuals sampled from each of the Group 1 and Group 2
populations. Since the sample sizes are the same in each group, this value is the value for N1, and also the value
for N2.
The Sample Size Per Group must be ≥ 2. You can enter a single value or a series of values.
N1 (Sample Size, Group 1)
This option is displayed if Group Allocation = “Enter N1 and N2 individually” or “Enter N1 and R, where N2 =
R * N1.”
N1 is the number of items or individuals sampled from the Group 1 population.
N1 must be ≥ 2. You can enter a single value or a series of values.
N2 (Sample Size, Group 2)
This option is displayed only if Group Allocation = “Enter N1 and N2 individually.”
N2 is the number of items or individuals sampled from the Group 2 population.
N2 must be ≥ 2. You can enter a single value or a series of values.
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R (Group Sample Size Ratio)
This option is displayed only if Group Allocation = “Enter N1 and R, where N2 = R * N1.”
R is the ratio of N2 to N1. That is,
R = N2/N1
Use this value to obtain N2 as a multiple (or proportion) of N1.
N2 is calculated from N1 using the formula:
N2=[R x N1],
where the value [Y] is the next integer ≥ Y.
For example, setting R = 2.0 results in a Group 2 sample size that is double the sample size in Group 1.
R must be greater than 0. If R < 1, then N2 will be less than N1; if R > 1, then N2 will be greater than N1. You can
enter a single value or a series of values.
Total Sample Size (N)
This option is displayed only if Group Allocation = “Enter total sample size and percentage in Group 1.”
This is the total sample size, or the sum of the two group sample sizes. This value, along with the percentage of
the total sample size in Group 1, implicitly defines N1 and N2.
The total sample size must be greater than one, but practically, must be greater than 3, since each group sample
size needs to be at least 2.
You can enter a single value or a series of values.
Percent in Group 1
This option is displayed only if Group Allocation = “Enter total sample size and percentage in Group 1.”
This value fixes the percentage of the total sample size allocated to Group 1. Small variations from the specified
percentage may occur due to the discrete nature of sample sizes.
The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single value or a series of
values.

Effect Size – Equivalence Limits
RU (Upper Equivalence Limit)
Enter the upper equivalence limit for the ratio of the two means. When the ratio of the means is between this value
and RL, the two means are said to be equivalent. The value must be greater than one. A popular choice is 1.25.
Note that this value is not a percentage.
If you enter 1/RL, then 1/RL will be calculated and used here. This choice is commonly used because RL and
1/RL give limits that are of equal magnitude on the log scale.
RL (Lower Equivalence Limit)
Enter the lower equivalence limit for the ratio of the two means. When the ratio of the means is between this value
and RU, the two means are said to be equivalent. The value must be less than one. A popular choice is 0.80. Note
that this value is not a percentage.
If you enter 1/RU, then 1/RU will be calculated and used here. This choice is commonly used because RU and
1/RU give limits that are of equal magnitude on the log scale.
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Effect Size – True Ratio
R1 (Actual Ratio)
This is the value of the ratio of the two means at which the power is to be calculated. Usually, the ratio will be
assumed to be one. However, some authors recommend calculating the power using a ratio of 1.05 since this will
require a larger sample size.

Effect Size – Coefficient of Variation
COV (Coefficient of Variation)
The coefficient of variation is the ratio of the standard deviation and the mean (SD/Mean). It is used to specify the
variability (standard deviation). Note that this COV is defined on the original (not logarithmic) scale. This value
must be determined from past experience or from a pilot study.
To be clear, consider the following definition. Suppose data on a response variable Y are collected. This
procedure assumes that the values of X = Ln(Y) are analyzed using a two-sample t-test. Thus, there are two sets
of means and standard deviations: those of X labelled MX and SX and those of Y labelled MY and SY. The COV
entered here is the COV of Y = SY/MY. For log-normal data, the following relationship exists: COV(Y) =
SQR(Exp(SX*SX)-1) where SX is the standard deviation of the log-transformed values.
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Example 1 – Finding Power
A company has developed a generic drug for treating rheumatism and wants to show that it is equivalent to the
standard drug. A parallel-group design will be used to test the equivalence of the two drugs.
Researchers have decided to set the lower limit of equivalence at 0.80. Past experience leads the researchers to set
the COV to 1.50. The significance level is 0.05. The power will be computed assuming that the true ratio is either
1.00 or 1.05. Sample sizes between 50 and 550 will be included in the analysis.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the procedure window. You may then make the appropriate entries as listed below, or open
Example 1 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Power
Alpha ....................................................... 0.05
Group Allocation ..................................... Equal (N1 = N2)
Sample Size Per Group .......................... 50 to 550 by 100
RU (Upper Equivalence Limit) ................ 1/RL
RL (Lower Equivalence Limit) ................. 0.80
R1 (Actual Ratio) .................................... 1.0 1.05
COV (Coefficient of Variation) ................ 1.5

Annotated Output
Click the Calculate button to perform the calculations and generate the following output.
Numeric Results
R = Treatment Mean / Reference Mean
Hypotheses: H0: R ≤ RL or R ≥ RU vs. H1: RL < R < RU

Power
0.00000
0.10488
0.48431
0.71704
0.84945
0.92208
0.00000
0.09731
0.43421
0.63661
0.76018
0.83961

N1
50
150
250
350
450
550
50
150
250
350
450
550

N2
50
150
250
350
450
550
50
150
250
350
450
550

N
100
300
500
700
900
1100
100
300
500
700
900
1100

Lower
Equiv
Limit
RL
0.800
0.800
0.800
0.800
0.800
0.800
0.800
0.800
0.800
0.800
0.800
0.800

Upper
Equiv
Limit
RU
1.250
1.250
1.250
1.250
1.250
1.250
1.250
1.250
1.250
1.250
1.250
1.250

R1
1.000
1.000
1.000
1.000
1.000
1.000
1.050
1.050
1.050
1.050
1.050
1.050

COV
1.500
1.500
1.500
1.500
1.500
1.500
1.500
1.500
1.500
1.500
1.500
1.500

Alpha
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050
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Report Definitions
Power is the probability of rejecting a false null hypothesis.
N1 and N2 are the number of items sampled from each population.
N is the total sample size, N1 + N2.
RL, RU are the lower and upper equivalence limits, respectively, and are the maximum allowable ratios that still
result in equivalence.
R1 is the actual ratio of the means at which power is calculated.
COV is the coefficient of variation on the original scale.
Alpha is the probability of rejecting a true null hypothesis.
Summary Statements ─────────────────────────────────────────────────────────
An equivalence test of means using two one-sided tests on data from a parallel-group design with sample sizes of
50 in the reference group and 50 in the treatment group achieves 0% power at a 5.0% significance level when the
true ratio of the means is 1.000, the coefficient of variation on the original, unlogged scale is 1.500, and the
equivalence limits of the mean ratio are 0.800 and 1.250.

This report shows the power for the indicated scenarios.

Plot Section

These plots show the power versus the sample size for two values of R1.
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Example 2 – Validation using Julious (2004)
Julious (2004) page 1971 presents an example of determining the sample size for a parallel-group design in which
the actual ratio is 1.0, the coefficient of variation is 0.80, the equivalence limits are 0.80 and 1.25, the power is
90%, and the significance level is 0.05. He calculates the per group sample size to be 216.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the procedure window. You may then make the appropriate entries as listed below, or open
Example 2 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size
Power ...................................................... 0.90
Alpha ....................................................... 0.05
Group Allocation ..................................... Equal (N1 = N2)
RU (Upper Equivalence Limit) ................ 1/RL
RL (Lower Equivalence Limit) ................. 0.80
R1 (Actual Ratio) .................................... 1.0
COV (Coefficient of Variation) ................ 0.80

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results
R = Treatment Mean / Reference Mean
Hypotheses: H0: R ≤ RL or R ≥ RU vs. H1: RL < R < RU

Target
Power
0.90

Actual
Power
0.90044

N1
216

N2
216

N
432

Lower
Equiv
Limit
RL
0.800

Upper
Equiv
Limit
RU
1.250

R1
1.000

COV
0.800

Alpha
0.050

PASS also calculates the per group sample size to be 216, which matches Julious’ result.
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